| WITH STANDARDS - UNLOCK THE POWER OF DATA

cdisc
2022
uUsS

INTERCHANGE
26-27 OCTOBER | AUSTIN

CDISC Perspective: Advancing Pre-Market Safety Analytics
Presented by Bess LeRoy, CDISC



Meet the Speakers
Bess LeRoy

Title: Head of Standards Innovation
Organization: CDISC

Bess has been a CDISC team member since 2011. She is a member of the

CDISC Technical Leadership Team and leads the CDISC Global Governance
Group. Bess has over 15 years' experience working in public health research
and has held positions at the Framingham Heart Study, the Rotterdam Study,

the Arizona Cancer Center, and the Critical Path Institute




Background

* Unnecessary variation in analysis results reporting

* Limited CDISC standards to support analysis results and associated
metadata

» CDISC has been working towards creating standards to support,
consistency, traceability, and reuse of results data

 Anticipate that the CDISC work will support sponsor submissions of analysis
results in a standard format that aligns with the new FDA effort to
standardize tables and figures
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£y Analysis Results Current State

Analysis Ready ADaM Dataset
: i '« May be hundred of tables in PDF TRy

S1 S/

e '.._ : [Row [STUDYID [USUBJID EDE( ASTDTM
- e MY o H 1| Xyz | 000001 |HYPO1|H: 07Scp2012 2
Siees ormat, often aliricuit to navigate
. . . 1 2 | XYZ | 000001 PO 2|H: 0Sej
. .." it 3 | XYZ | 000001 |HYPO 3 Hypoglycemia N 10Sep2012 23:05:00
| — ® . — 4 | XYZ | 000001 |HYPO4|Hypoglycemia| N 11S¢p2012 15:24:00
... *» Variability between sponsors N N o e
o § 6 XYZ | 000002 HYPO 1 |Hypoglycemia N 220ct2012 13:28:00
?Z_' et a 4 7 XYZ | 000002 |HYPO 2 |Hypoglycemia N 250¢t2012 13:59:00

° Expensive to gen erate and on Iy -

used once, no or limited reusability

* «  Limited traceability

Static Display
cdisc



Analysis Results Current State

Table 3.1.1: ADHYPO Analysis Dataset

| Row |STUDYID | USUBJID | MIDS | CEDECOD |WASAEYN ASTDTM
1 XYZ 000001 (HYPO 1|Hypoglycemia Y 07Sep2012 22:29:00
2 XYZ 000001 [HYPO 2 |Hypoglycemia N 10Sep2012 09:12:00
3 XYZ 000001 |HYPO 3 |Hypoglycemia N 10Sep2012 23:05:00
4 XYZ 000001 [HYPO 4 |Hypoglycemia N 11Sep2012 15:24:00
5 XYZ | 000001 |HYPO 5|Hypoglycemia N 18Sep2012 11:39:00
6 XYZ 000002 [HYPO I |Hypoglycemia N 220ct2012 13:28:00
7 XYZ 000002 [HYPO 2 |Hypoglycemia N 250ct2012 13:59:00
8 XYZ 000002 (HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00

ADaM Dataset

Table 4.2.1: HbAlc Longitudinal Repeated Measures Analysis - Table Shell
Protocol: Xz Page 1 of 2
Hbalc (%) Longitudinal Repeated Measures Analysis
24-Wesk Short-tem Double-blind Treatment Period
Intention-to-treat Population

Drug & rug B
N=125 Ne125
EASELDE W 125 25
Mean (D) XK (X 30) XK (X.30%)
[ N 000 000
Change from baseline: Mean (SD) X0 (X000 XK (X000
Adjusted change £ iseline: Mean (SD) X0 (X.300) XXX (X.3000)
95% Confidence interval for adjusted mean (KKK, KK.X) (3%, XK.X)
Difference vs. Drug B (SE RRRK (K. 30000)
5% Confidence intarval for difference 003X, XK.X)
P-value vs. Drug B
WEER 12 X3 ( X.3000 XK (X300
X3 (X000 X3 (%2000
X (X30) XXX (X.300)
Difference vs. Drug B (SE) (KKK, XK.X) (.3, XK.X)
55% Confidence interval for difference 00300 ( X.30000)
-valus vs. Drug B 00308, XK. X)
x.
T the mmber of mbjects In the Tnvention-totrest (IT3) Fopalation.
Ni: the mumber of subjects in the ITT cicn with nen-missing baseline and non-missing Wesk t value.
Repested messures medel: change = bassline tresthent viei visititrestment
Progran Source: xcncoood\aoi\soooe\t-Hbalo—repmeas  sas <date>:<tins>

Static Display

ARM for Define-XML

Table 4.2.2: HbAlc Longitudinal Repeated Measures Analysis Results Metadata

Metadata Field Metadata

DISPLAY IDENTIFIER Table 4.2.1/Figure 4.2.1

DISPLAY NAME Mean Change from Baseline in HbAlc (Percent) L itudinal Rep d M Analysis, 24-Week Short-term Double-blind Treatment
Period, Intention-to-treat Population

RESULT IDENTIFIER Treatment difference results (LSMean. confidence interval, p-value)

PARAM HbAlc (%)

PARAMCD HBAIC

ANALYSIS VARIABLE CHG (Change from baseline)

ANALYSIS REASON SPECIFIED IN SAP

ANALYSIS PURPOSE PRIMARY OUTCOME MEASURE AR M V’]

ANALYSIS DATASET ADHBAIC

cdisc



Analysis Results Future State

Table 3.1.1: ADHYPO Analysis Dataset

Row |STUDYID | USUBJID| MIDS | CEDECOD |WASAEYN ASTDTM
1 XYZ 000001 [HYPO 1 |Hypoglycemia Y: 07Sep2012 22:29:00
2 XYZ 000001 |HYPO 2 |Hypoglycemia N 10Sep2012 09:12:00
3 XYZ 000001 [HYPO 3 |Hypoglycemia N 10Sep2012 23:05:00
4 XYZ 000001 |HYPO 4|Hypoglycemia N 11Sep2012 15:24:00
5 XYZ 000001 |HYPO 5 |Hypoglycemia N 18Sep2012 11:39:00
6 XYZ 000002 |HYPO 1 |Hypoglycemia N 220ct2012 13:28:00
7 XYZ 000002 [HYPO 2 |Hypoglycemia N 250c¢t2012 13:59:00
8 XYZ 000002 |HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00

ADaM Dataset
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Analysis Results Future State

Table 4.2.2: HbAlc Longitudinal Repeated Measures Analysis Results Metadata

Metadata Field Metad.

DISPLAY IDENTIFIER Table 4.2.1/Figure 4.2.1

DISPLAY NAME Mean Change from Baseline in HbAlc (Percent) L itudinal Repeated M Anal
Period. Intention-to-treat Population

RESULT IDENTIFIER Treatment difference results (LSMean, confidence interval, p-value)

PARAM HbAlc (%)

PARAMCD HBAIC

ANALYSIS VARIABLE CHG (Change from baseline)

ANALYSIS REASON SPECIFIED IN SAP

ANALYSIS PURPOSE PRIMARY OUTCOME MEASURE AR M \Y 1

ANALYSIS DATASET ADHBAIC

Table 3.1.1: ADHYPO Analysis Dataset

e 8% Row [STUDYID |USUBJID| MIDS | CEDECOD |WASAEYN ASTDTM

& e ° 1 XYZ 000001 |HYPO 1 |Hypoglycemia Y 07Sep2012 22:29:00

. : 2 XYZ 000001 |HYPO 2 |Hypoglycemia N 10Sep2012 09:12:00
3 XYZ 000001 [HYPO 3 |Hypoglycemia N 10Sep2012 23:05:00
4 XYZ 000001 |HYPO 4|Hypoglycemia N 11Sep2012 15:24:00
5 XYZ 000001 [HYPO 5 |Hypoglycemia N 18Sep2012 11:39:00
6 XYZ 000002 |HYPO 1|Hypoglycemia N 220ct2012 13:28:00
7 XYZ 000002 [HYPO 2 |Hypoglycemia N 250c¢t2012 13:59:00
8 XYZ 000002 [HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00

ARM Extension Technical Specification

ADaM Dataset

cdisc




Analysis Results Future State

Table 3.1.1: ADHYPO Analysis Dataset

Row |STUDYID | USUBJID| MIDS | CEDECOD |WASAEYN ASTDTM
1 XYZ 000001 [HYPO 1 |Hypoglycemia Y: 07Sep2012 22:29:00
2 XYZ 000001 |HYPO 2 |Hypoglycemia N 10Sep2012 09:12:00
3 XYZ 000001 [HYPO 3 |Hypoglycemia N 10Sep2012 23:05:00
4 XYZ 000001 |HYPO 4|Hypoglycemia N 11Sep2012 15:24:00
5 XYZ 000001 |HYPO 5 |Hypoglycemia N 18Sep2012 11:39:00
6 XYZ 000002 |HYPO 1 Hypoglycemia N 220ct2012 13:28:00
7 XYZ 000002 [HYPO 2 |Hypoglycemia N 250c¢t2012 13:59:00
8 XYZ 000002 |HYPO 3 |Hypoglycemia N 17Nov2012 05:01:00

ADaM Dataset

ab:Observation ‘qh:hhh

1001 dm.summary

1033 gm.summary it

‘ dim.parameter | dim.sex

param.subjects
param.subjects
param.subjects
param.subjects
param subjects
param.subjects

sexALL

param.subjects  sex!

param.subjects
param subjects
param.subjects
param.subjects

dim.agocat | dim.statistic { analysisRosult
sgecalALL statfreq 100
agecat AL statfreq 60
agecat AL stat percont
agecal ALl statfreq 40
agecal AL stat percent 40
agecatALL  statfreq 50
agecalALL  statfreq 30
agecat AL stat percent &0
agecat AL stat froq 2
agecal AL stat percert 40
agecalALL  statfreq 150
stat freq %
stat percent 60
stat freq 60
stat percent 40
statfroq 100
statmean 07
stat stdev 107
stat median 370
statmin 210
tat. 660
stat freq 50
stat moan a2
stat stdev 103
stat median 360
statmin 230
tat max 670
statfreq 150
stat moan 40
stat stdov 104
stat median 370
statmin 210
statmax 670

Table 4.2.2: HbAlc Longitudinal Repeated Measures Analysis Results Metadata

Metadata Field Metad.

DISPLAY IDENTIFIER Table 4.2.1/Figure 4.2.1

DISPLAY NAME Mean Change from Baseline in HbAlc (Percent) L itudinal Repeated M Anal
Period. Intention-to-treat Population

RESULT IDENTIFIER Treatment difference results (LSMean, confidence interval, p-value)

PARAM HbAlc (%)

PARAMCD HBAIC

ANALYSIS VARIABLE CHG (Change from baseline)

ANALYSIS REASON SPECIFIED IN SAP

ANALYSIS PURPOSE PRIMARY OUTCOME MEASURE AR M \Y 1

ANALYSIS DATASET ADHBAIC

ARM Extension Technical Specification

Automation

Table 4.2.1: HbAlc Longitudinal Repeated Measures Analysis - Table Shell

cd

ISC

Analysis Results Dataset

Change from baseline: Mean (SD)
Adjusted change from baseline: Mean (SD)
95% Confidence interval for adjusted mean
Difference vs. Drug B (SE)

95% Confidence interval for difference
P-value vs. Drug B

erotocol: X1z rage 1 of 2
Hblc (%) Longitudinal Repeated Measures Analysis
24-Wesk Short-term Double-blind Treatment Period
Intention-to-treat Populati
Drug & Drug B
N-12: ¥-125
BASLINE | NF 1z 125
Mean (sD) KKK (K200 KKK (KHKK)
WEEK 4 Nt
Change from baseline: Mean (SD) R (X000 XK (X000
Adjusted change from baseline: Mean (SD) KKK (X300 KKK (XHKK)
95% Confidence interval for adjusted mean (KX, KK.K) OO, KKK)
Difference vs. Drug B (SE) REKK (20000
95% Confidence interval for difference (XK, KKX)
P-value vs. Drug B x.
WEEK 12 3 XK( X.300) XXX (X300

Reuse

i the bz of mbjacte In the Intention totrest (I77) Population.
N: the mmber of subjects in the TTT populaticn

Fepeated messures model: change

Program Source: x0000000(\10000\2000¢\t-hbal o repmeas .sas

with nonemi

=sing baseline and non-missing Week t value.
= baseline treatment visit visititreatment

<date>:<time>

Traceability

Display




Analysis Results Standards Goals

<0

{.a Model that describes analysis results and associated metadata

Analysis Results Metadata Technical Specification (ARM-TS), to
support automation, traceability, and creation of data displays

‘@)

Define an Analysis Results Data (ARD) structure, to support reuse
and reproducibility of results data

y lllustrate and exercise ARD and ARM-TS with a set of machine-
N readable common safety displays

cdisc



5?;;;:-55? Key Metadata Elements of a Table

o . TITLE
e Display Template Title subtitle ) | Analysis Set
? : ' (Subtitle 2) D|Sp|ay
.. Analysis :,roup Heading 1 Heading 2 Heading 3 Heading 4
i 2 <-straddle->-------mmmmmmmmmmaeeo
. . Column 2 Row ]
Lo @
‘ o Body
s Legend | Legend
s Abbreviations | Abbreviations D|Sp|ay
e e Footnote

Reference: PHUSE White Paper “General Output Tips and Considerations”, Doc ID: WP-034, Version 1.0, Aug 2020

cdisc



Demographics Analysis Results and Metadata

Display Template Title Analysis Set
‘ '.'! Table 2. Baseline Demographic and Clinical Characteristics, Safety Population, Pooled Analyses (or Trial X)
B.uieh Drug Name Drug Name Total
: . Dosage X Dosage Y Placebo  Active Control Population
R Analysis Group N = XXX N = XXX N = XXX N = XXX N = XXX
IO Characteristic n (%) n (%) n (%) n (%) n (%)
. Sex, n (%) n (%) n (%) n (%) n (%) n (%)
Pt . Male n (%) n (%) n (%) n (%) n (%)
A Female n (%) n (%) n (%) n (%) n (%)
g Age, years XX (Y.Y) XX (Y.Y) XX (Y.Y) XX (Y.Y) XX (Y.Y)
S S A Mean (SD) XX (YY) XX (YY) XX (YY) XX (YY) XX (YY)
i Median (min, max) XX(Y.Y,Z2.2) XX(Y.Y,Z2.2) XX(Y.Y,Z2.Z) XX(Y.Y,Z2.2) XX(Y.Y,Z2.Z)
5 Age groups (years), n (%) = L) e 013 A n (%)
I 2‘13; to <65 Result ; Result Where Result  |n g:f;
o = i iati n (%
65 to <75 Group ) Variable Clause Statistics |, (%)
275 n (%) n (%) n (%) n (%) n (%)
Race, n (%) n (%) n (%) n (%) n (%) n (%)
American Indian or Alaska Native Asian n (%) n (%) n (%) n (%) n (%)
Black or African American n (%) n (%) n (%) n (%) n (%)
Native Hawaiian or Other Pacific Islander n (%) n (%) n (%) n (%) n (%)
White n (%) n (%) n (%) n (%) n (%)
Other n (%) n (%) n (%) n (%) n (%)
Source: [include Applicant source, datasets and/or software tools used].
' Difference is shown between [treatment arms] (e.g., difference is shown between Drug Name dosage X vs. placebo).
Abbreviations: N, number of patients in treatment arm; n, number of patients with given characteristic; SD, standard deviation
Footnote Abbreviations Legend FDA Standard Safety Tables and

CdlSC Figures Integrated Guide



2 Analysis Results Dataset Example: Demographics

: ) e
il Identifiers Analysis Group Result Variable Results Statistic
osssing a
Y e Name Title Dataset | Variable Value Variable | Value | Label | Value | Name | Label
‘ """ e Baseline Demographics and
g . . Drug Name
.o Table 2 | Clinical Characteristics, Safety | ADSL TROIX Dosage X SEX M Male 53 Count n
gty Population &
sEaWne Baseline Demographics and
#:-i:¢ [ Table2 | Clinical Characteristics, Safety | AD TROIX EX M Male 1. Percent A
BoLE . Dosage X
i Population
a Baseline Demographics and
.. . Drug Name
Table 2 | Clinical Characteristics, Safety | ADSL TRO1X Dosage X SEX F Female 33 Count n
Population &
Baseline Demographics and Drue Name
Table 2 | Clinical Characteristics, Safety [ ADSL TRO1X Doga e X SEX F Female | 38.4 | Percent %
Population &

Traceability to the underlying ADaM dataset



Machine Readable TFL Shells

1 koxml oding="UTF-8"2>
2 <TableShell>

E ID>TEAE.01</ID>

4 <Ordinal>1</Ordinal

s <Type>Table</Type>

e <Name>TEAE-Overall</Name>

7 <Title>Overall Summary of Treatment Emergent Adverse Events</Title>
] <Population>Safety Population</Population>

9v <ColDefs

0 TreatmentVar *TRTOL" ge "ST.0
1w <ComputeCols>

12 <ComputeCol a1l "ST.01"
13 /ComputeCols

14 </ColDefs>

15 <ResultGroupDef "EAE.01.GRE.01" 1>
19 b <ResultGroupDef "TEAE 02" "2ms
2) <ResultDef TEAE.01.GRP.0L.RES.01"> [4 lines]
27 <ResultDef "TEAE.01.GRP.01.RES.02

28 Label>Subjects with a related AE</Label>

2 StatRef "ST.01"/

20 <StatRef "ST.02"

at </ResultDef>

2v <ResultDef "TEAE.01.GRP.02.RES. 01"

as Label>Number of AEs</Label>

as <StatRef "ST.0L"/>

35 </ResultDef

B> <StatDef "ST.0L" N>

a7 <Label>Number of Subjects</Label>

28 ¢Format>XXg/Format>,

28 </StatDef

v <StatDef "ST.02" "BCT">

41 <Label>Percentage of Subjects</Label>

%2 Format> (KX.X$) </Format>

a2 </StatDef>

44 </TableShell

45

Adverse Events

Table 35. Patients With Adverse Events' by System Organ Class, Safety Population, Pooled Analysis (or Trial

Drug Name Drug Name
Dosage X Dosage Y Active Control Placebo Risk
N = XXX N = XXX N = XXX N=XXX Difference (%)
System Organ Class n (%) n (%) n (%) n (%) (95% CI)*4
Blood and lymphatic system n (%) n (%) n (%) n (%) XANZ)
_Cardiac disorders n (%) n (%) n (%) n (%) X(Y,2)
Ear and labyrinth disorders n (%) n (%) n (%) n (%) X(Y,2)
_Endocrine disorders n (%) n (%) n (%) n (%) X(Y,2)
Eye disorders n (%) n (%) n (%) n (%) X(Y,2)
Gastrointestinal disorders n (%) n (%) n (%) n (%) X(Y,2)
Hepatobiliary disorders n (%) n (%) n (%) n (%) X(Y,2)
Immune system disorders n (%) n (%) n (%) n (%) X(Y,2)
Infections and infestations n (%) n (%) n (%) n (%) XANEZ)
Injury, poisoning and procedural complications n (%) n (%) n (%) n (%) X (Y, 2)

Source: [include Applicant source, datasets and/or software tools used].
T Treatment-emergent adverse event defined as [definition].

2 Duration = [e.g., X week double-blind treatment period or median and a range indicating pooled trial durations).

# Difference is shown between [treatment arms] (e.g., difference is shown between Drug Name dosage X vs. placebo).
“Table display is ordered by the risk difference.

Abbreviations: Cl, confidence interval; N, number of patients in treatment arm; n, number of patients with at least one event

Develop schema/model for
machine readable TFL shells

cdisc




End Goal: Reducing Unnecessary Variability

Standardized Metadata

CDASH

SDTM ADaM - Analysis

(Collection) (Tabulation) (Analysis) Results

2
@ e o
SENIGIRE, e 0o
B Ll cdisc (TT1 [T T[] Adverse Events
St Numbar
°- Table 35. Patients With Adverse Events’ by System Organ Class, Safety Population, Pooled Analysis (or Trial X)*
Drug Name
' . Dosage X Dosage Y  Active Control Placebo Risk
) Form AE - Adverse Events s o o N= X)% N= X(XX N= X(XX N= X():)g Di"ﬂ;;’:/ucrﬂ
. ystem Organ Class n n n n (%) (95% CIp¢
i - 1 AE - Adverse Events Blood and lymphatic system i n( n( T (%) X(Y.2)
, g 11 |Were any adverse events [~ ,, No AEYN Cardiac disorders n ( n( n( n (%) X(Y,2)
experienced? On Yes ar and labyrinth disorders n( n( n( n (%) X(Y,2)
ine disorders n ( n( n( n (%) X(Y,2)
° 12 |Whatis the adverse event AETERM “Eye disorders n ( n n( n (%) X (Y. Z)
. term? “Gastrointestinal disorders n ( n( n ( n (%) X (Y. 2)
¥ _Hepatobiliary disorders n( n (¢ n (¢ n (%) X(Y,2)
<9 e v [ B [AESTOAT, mmune system disorders n n ( n ( (%) X(Y.2)
S 08 _Infections and i i n( n(’ n (¢ n (%) X(Y,2)
Bisiavacnm 14 [Ongoing  w No AEONGO njury poisoning and procedural complications n ( n ( n ( n (%) X (Y. 2)
o Yes Source: [include Applicant source, datasets and/or software tools used].
" Treatment-emergent adverse event defined as [definition].
15  |End Date AEENDAT 2 Duration = [e.g., X week double-blind treatment period or median and a range indicating pooled trial durations].
(DD-MMM-YYYY) 2 Differenceis shown between [treatment arms] (e.g., difference is shown between Drug Name dosage X vs. placebo).
“Table display is ordered by the risk difference.
16 |Severity s Mild AESEV Abbreviations: Cl, confidence interval; N, number of patients in treatment arm; n, number of patients with at least one event
(" mocews Moderate
e Severe




" Support for FDA Standard Safety Tables and Figures

R Model that describes analysis results metadata

-1« For a selection of FDA tables and figures, create packages
"4t containing

b  Machine readable displays

» Associated analysis results metadata

» Analysis results dataset examples

* Underlying ADaM datasets

» Make packages freely available on the CDISC website

cdisc



